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Opas SAS Enterprise Guiden kayttajalle

Hurme, Timo
MTT, Kasvintuotannon tutkimus, 31600 Jokioinen, timo.hurme@mitt.fi

Tiivistelma

SAS Enterprise Guide on tilastollinen ohjelmisto, joka vaatii toimiakseen myds tavallisen SAS-
ohjelmiston. Enterprise Guide on helppokayttdinen vaihtoehto SAS-ohjelmiston monipuolisten
ominaisuuksien hyodyntamiseen.

Enterprise Guiden graafisessa kéyttoliittyméssd voidaan muokata tutkimusaineistoja, piirtdd ku-
via, laskea kuvailevia tunnuslukuja ja tehdi tilastollisia analyysejd. Tdssd oppaassa tutustutaan
Enterprise Guiden kayttoymparistoon, datojen kisittelyyn seké aineiston alustavaan tarkasteluun
muun muassa kuvien ja tilastollisten tunnuslukujen avulla. Liséksi tutustutaan Enterprise Guiden
yleisiin ominaisuuksiin.

Opas on suunnattu 1dhinnd maa- ja elintarviketalousalan tutkijoille ja muulle tutkimusvielle.
Siitd on kuitenkin hyotyd muillekin SAS Enterprise Guiden kayttijille.

Avainsanat:
SAS Enterprise Guide 4.2, tilastollinen ohjelmisto, kuvaileva tilastotiede, aineiston tarkastelu
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1 Johdanto

SAS Enterprise Guide (EG) on graafinen hiirelld ohjattava SAS-ohjelmiston kédyttoliittyma, joka
madaltaa SASin kayttoonottokynnystd. EG:ssd hiirelld tehtdvit valinnat generoivat taustalla
SAS-koodia, joka suoritetaan automaattisesti perinteisessd SASissa. Tulokset palautuvat esitetté-
viksi EG:ssa ja niiden ulkoasu noudattaa viimeisintd SAS-tekniikkaa. Niinpd Enterprise Guide ei
ole itsendinen ohjelma, vaan se vaatii toimiakseen my0s perus-SASin. Téssd oppaassa kiytetddn
SAS Enterprise Guiden versiota 4.2 yhdessd SAS 9.2:n kanssa. EG toimii ainoastaan Windows-
ympéristdssd, ja tdssd oppaassa rajoitutaan tilanteeseen, jossa molemmat — EG ja perus-SAS —
ovat asennettu samalle paikalliselle tietokoneelle (local). Oppaan kirjoittajalla on ollut kéytos-
sdadn Microsoft Office 2003 -versio, joka saattaa epdsuorasti vaikuttaa tiettyihin oppaassa kuvat-
tuihin EG:n toimintoihin. Liséksi on syytd mainita, ettd opasta tehtdessd kdytossd ei ole ollut
SASin ”Add-In for Microsoft Office” -tuotetta, joka toisi mukanaan lisdtoimintoja Microsoftin
ohjelmien ja SASin yhteiskdyttoon.

Enterprise Guiden graafisessa kayttoliittyméssd voidaan muokata tutkimusaineistoja, piirtdd ku-
via, laskea kuvailevia tunnuslukuja seké tehdi tilastollisia analyysejd. Perinteinen SAS-kaytto
voidaan my0s yhdistdd EG:n helppouteen, silld EG:ssa voidaan kéyttdd SAS-koodia. EG:n vah-
vuutena on myo0s tulosteiden, kuten kuvien ja taulukoiden, helppo siirrettdvyys muihin ohjelmiin,
esimerkiksi Microsoft Word -ohjelmaan. Oppaassa keskitytdén datan kdyttoonottoon ja muok-
kaukseen sekd datan havainnollistamiseen kuvien ja tunnuslukujen avulla. Lisdksi kdydéaan lapi
EG:n kayttoympéristod ja yleisid ominaisuuksia.

Tédmi opas on suunnattu ensisijaisesti maa- ja elintarviketalousalan tutkijoille ja muulle tutki-
mushenkilokunnalle. Lahestymistapa on suunniteltu niin, ettd materiaali soveltuu erityisesti
aloitteleville SAS Enterprise Guiden kéyttéjille. Toivon mukaan opas on kuitenkin kéyttokelpoi-
nen myd6s muilla aloilla toimiville EG:n kéyttédjille sekd hieman kokeneemmillekin kayttdjille.
Opas perustuu useiden Enterprise Guide peruskurssien kurssimateriaaleihin. Timédn oppaan ra-
kenne noudattaa Hurmeen (2007) aiemman oppaan rakennetta, mutta sisidltd on muokattu SAS
Enterprise Guiden uuden 4.2 version mukaiseksi.

Tdhdn oppaaseen on lisdtty eri tyOkalujen yhteyteen vaihtoehtoiset SAS-koodiratkaisut. SAS-
koodin avulla voidaan tiettyjd toimintoja suorittaa helpommin ja nopeammin, varsinkin jos vaa-
ditaan rutiininomaista tyovaiheen toistoa. Kussakin koodiratkaisuissa on pyritty esittdmadn yksi
yksinkertainen tapa tehtdvin ratkaisemiseen. Koodiratkaisun tarkoituksena on toimia muistin
virkistdjdnd perustilanteissa ja niinpa kaikkia yksityiskohtia ei ole tyhjentavisti selitetty. Ongel-
matilanteissa kannattaa avata EG:ssd "Help” -> ”SAS Syntax Help” ja hakea avautuvasta laajasta
SAS-manuaalista lisédtietoa koodin yksityiskohdista. Tétd EG-opasta kattavampi esitys SAS-koo-
din kdytostd 16ytyy muun muassa Marko Laineen (2000) SAS peruskurssi -oppaan verkkopai-
noksesta.

Muutamia Enterprise Guidessa kaytettyjd englanninkielisid ilmauksia on syytd tdsmentdi.
EG:ssé sanoilla ”Column” ja ”Variable” tarkoitetaan samaa asiaa. Néilld tarkoitetaan muuttujaa
ja sen arvoja eli saraketta datamatriisissa. My0s sanat "Rows” ja ”Observations” tarkoittavat kes-
kenddn samaa asiaa eli havaintoa (rivid) datamatriisissa. [lmaukset ”SAS data table” ja ”SAS
data set” puolestaan molemmat tarkoittavat SAS-dataa.

Haluttaessa tutustua laajemmin tilastollisten menetelmien soveltamiseen SAS Enterprise Gui-
della, kannattaa tutustua Heleniuksen ja Vahlbergin (2008) kirjaan, jossa on esitetty tilastome-
netelmien soveltamisesimerkkejd EG:n versiolla 4.1. Englanninkielisistd kirjoista Slaughterin ja
Delwichen (mm. 2006) kirjat tarjoavat hyvén johdannon EG:n peruskdyttoon.
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2 Oppaassa kaytettavat datat

Kaikki kolme oppaassa kéytettdvid aineistoa 10ytyvit internetistd (http://www.mtt.fi/mttraportti/
pdf/egdata/EG42datat.zip). Aineistoja tarvitaan oppaan harjoitus-tehtdvid tehtdessd, mutta
harjoitusmateriaalina voi vaihtoehtoisesti kdyttdd my0s muita vastaavan tyyppisid aineistoja.
Kaytettdvit aineistot kannattaa tallentaa omalle tietokoneelle esimerkiksi "Omien tiedostojen”
(tai "My Documents”) alle alikansioon \SAS\EGKURS, jota kéytetidén oppaan esimerkkien tal-
lennuspaikkana tai esimerkiksi kansioon C:\SAS\EGKURS.

Ohra-aineisto

Ohra-aineisto on simuloitu kuvitteellinen osaruutukokeen tulosaineisto. Kokeessa on tutkittu
ohran satoa eri lajikkeilla ja lannoitetasoilla. Pddruututekija on lannoitetaso, jonka luokat (kolme
lannoitetasoa) on arvottu padruutuihin satunnaistettujen tiydellisten lohkojen koekaavion mukai-
sesti. Lohkoja kokeessa on neljd. Osaruututekijd on ohralajike, jonka luokat (neljé eri lajiketta)
on tdydellisesti satunnaistettu osaruutuihin erikseen jokaisen pddruudun sisélld. Aineisto on tal-
lennettu Excelissd nimelld OhraData.xlIs. Aineistosta 10ytyvit seuraavat muuttujat:

. lohko:
1
2
3
4
. lajike:
A="Arvo”
B="Bertta”
C="Ceclile”
D="Daavid”
. lannoite (kg/ha):
280
300
320
. sato (kg/ha)

Viljelij& 2006 -aineisto

Viljelija 2006 -aineisto perustuu kuvitteelliseen kyselytutkimukseen, jossa 54 tilanomistajalta on
kysytty erilaisia maatilaan ja itse viljelijdén liittyvid kysymyksid. Aineisto on tallennettu Ex-
celissd nimelld Viljelija2006.xls. Aineistosta 16ytyvit seuraavat muuttujat:

. id (havainnon tunnistenumero)
. nimi (viljelijan etunimi)
sukup (viljelijan sukupuoli):
1="Mies”

2="Nainen”
peltoa (peltoa hallinnassa, ha)
nautoja (nautoja omistuksessa, kpl)
metsaa (metsdd omistuksessa, ha)
tuotsuun (pédtuotantosuunta):
1="Peltoviljely”
2="Kotieldimet”
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o paino (viljelijén paino, kg)
o pituus (viljelijan pituus, cm)
o ika (viljelijén ikd vuosina)
o tulot (viljelijan vuositulot euroina)
o ajanmuk (tilan ajanmukaisuus):
1="Huippumoderni”
2="Ajan hermolla”
3="0K”
4="Vidhén perdssi”
5="Alkukantainen”
. tulevais (tilan tulevaisuudennikymat):
1="Hyvat”
2="0K”
3="Huonot”

Eldinten painot -aineisto

Eldinten painot -aineisto on kuvitteellinen kokeellinen toistomittausaineisto. Kymmenen saman
pentueen kettua on heindkuussa tapahtuneen vieroituksen yhteydessa tdydellisesti satunnaistettu
kahteen eri késittelyryhmiin. Kettujen painon kehitystd on seurattu elokuusta joulukuuhun nel-
jénd eri ajankohtana. Aineisto on tallennettu SASissa nimelld KetutData.sas7bdat sekd Ex-
celissd nimelld K etutData.xls. Aineistosta 10ytyvit seuraavat muuttujat:

e ID (ketun tunnistenumero)
e ryhma (kisittelyryhma):

A

B
elokuu (ketun paino elokuun mittauksessa, kg)
syyskuu (ketun paino syyskuun mittauksessa, kg)
lokakuu (ketun paino lokakuun mittauksessa, kg)
joulukuu (ketun paino joulukuun mittauksessa, kg)
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3 Enterprise Guiden kayttoymparisto

Avattaessa Enterprise Guide, perusndkyma on olennaisilta osiltaan seuraava:

Ylévalikot ja tyokalurivin pikapainikkeet.

[ SAS Enterprise Guide

File Edit Wiew Tasks Program  Tools  Help %'ﬁ' ) 5 ye By B & 2] - SﬁprocessFlow -
Project Tree - X Process‘FIow -
g‘!“%PfUCBSSHUW Zoom - E—EijectLog [#] Properties -
Projektipuu T
(’Project Tree”). Asiayhteysvalikko (“’context-sensitive toolbar”),
jonka sisdltd riippuu tyoétilassa auki olevasta
kohteesta.
Viimeksi kiytettyjen osioi- Tydtila, jossa tdssd kuvassa ndkyvissd tyhja
den valikko (“recently vie- prosessidiagrammisivu ("Process Flow”).
wed items menu”).

Serwver List

% (50 |© «—— Muut ikkunat: “Task List”, ”SAS Folders”,

”Server List” ja ”Prompt Manager”.

+ Servers
£ J_Eb Private OLAP Servers

Perusnikyma sisiltia tyotilan, johon avautuvat muun muassa tarkasteltavat aineistot ja suoritet-
tujen tehtdvien tulosteet. Tyotilassa nikyy my0s prosessidiagrammi (tyokalurivin ”Process
Flow” -pikapainikkeesta), joka palvelee samaa tarkoitusta kuin projektipuu. Molempiin kertyy
istunnon aikana tehdyista tehtévista jalki, joka voidaan tallentaa ja ottaa kdytto6on uudessa istun-
nossa. Jalki eli EG-projektikokonaisuus siséltdd erillisid kuvakkeita eli solmuja (pddasiassa teh-
tdvdsolmuja ja tulossolmuja) suoritetuista toimenpiteistd. Tyotilassa on myos koko ajan néky-
vissd niin sanottu asiayhteysvalikko, josta valittavissa olevat toimenpiteet riippuvat siitd mita
tyotilassa on samalla hetkelld aktiivisena tarkastelussa.
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Alla olevassa kuvassa nikyy esimerkkind prosessidiagrammijélked ja siithen liittyva
asiayhteysvalikko:

= Run = Export = Schedule = | Zoom E}iject Lag | [#] Properties =
@
Ed5E = I
WILJ2006_... Scatter Plot HTML -
Scatter P...
m
@'
[mr |
545 Report
-Scatte...
o
Line Plot
o

Yksittdiseen tehtdvadn liittyvat kdytetyt datat, koodit, logit ja tuloksena syntyneet datat ja/tai
tulosteet on ryhmitelty esitettdviksi yhteen tyétilaan avautuvaan vililehdille jaoteltuun néky-
maiin. Tuplaklikkaamalla aiemmin méiériteltyd ja suoritettua tehtdvdsolmua prosessidiagram-
mista saa esille kyseisen vililehtindkymaén:

B3 Input Data jl Code | [Z] Log ftal Results
ij Refresh |_TJ_ Maodify Task | Export = Send To = Create - \#] Properties

Vililehtien vililld selailemalla, voidaan helposti ja nopeasti tutkia kéytettyd dataa (“Input Data”),
tehtdvin luomaa SAS-koodia (”Code”), suorituksen yhteydessd muodostettua logia (Log”) ja
tehtidvin tulostetta (“Results”). Aiemmin maéériteltyjd tehtdvdsolmuja piddsee muokkaamaan
avaamalla ne ylld olevan kuvan nidkymdiin (tuplaklikkaamalla prosessidiagrammista) ja valitse-
malla asiayhteysvalikosta "Modify Task”. Yksittdiseen tehtdvisolmuun liittyvistd jatkotoimen-
piteistd saa valikon esiin myds klikkaamalla tehtdvésolmua hiiren oikealla painikkeella suoraan
prosessidiagrammissa.

Edelld mainittujen tehtdvéa- ja tulossolmujen sekd niihin liittyvien SAS-koodien ja logien lisdksi
Enterprise Guiden projektikokonaisuus pitdéd sisdlldin muun muassa datoihin viittaavia kuvak-
keita ja muistiinpanoja toisiinsa linkitettyini. Projektikokonaisuutta voi myos jakaa useammalle
erilliselle prosessidiagrammisivulle (Process Flows). Uusia vélilehtid saa kdyttoon valitsemalla
”File” -> "New” -> “Process Flow”. Erillisten prosessidiagrammisivujen ja muiden osioiden
(muun muassa “Custom Reports”) vililld voi selailla joko tydkalurivin viimeisen painikkeen
(edellisen sivun kuvan ”Process Flow” -painike) tai viimeksi kéytettyjen osioiden valikon kautta.
Liséksi osioiden vililld on kéteva liikkua kdyttden projektipuuta.

Tyotilassa on oletuksena samanaikaisesti nikyvissd vain yksi tarkastelun kohde (esimerkiksi
prosessidiagrammi, data tai tuloste). Useampaa kohdetta voidaan tarkastella samanaikaisesti va-
litsemalla tyokalurivin ”Workspace Layout” -pikapainikkeesta vaihtoehto ”Stacked” tai ’Side By
Side”, joiden avulla saadaan samanaikaisesti ndkyviin kaksi kohdetta joko paillekkdin tai rin-
nakkain. Tamin avulla voidaan esimerkiksi kdyttdd Enterprise Guidea siten, ettd prosessi-
diagrammi on koko ajan ndkyvissé toisessa ikkunassa ja valintoja tehtdessd niiden tulokset au-
keavat toiseen ikkunaan.
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Suoritettavien tehtivien eteneminen nékyy Enterprise Guide 4.2:ssa alapalkissa suorituksen ajan.
Talloin se voidaan myds klikata ndkyviin suurempaan ikkunaan valitsemalla ”(Details)”. Ai-
neistojen kdsittelyyn ja niistd tehtéviédn tarkasteluun liittyvét varsinaiset SAS Enterprise Guide -
tyokalut 10ytyvét sekd asiayhteysvalikon, tehtdvélistan ("Task List”) ettd “Tasks”-ylavalikon
kautta. Tdssd oppaassa tehtdvét suoritetaan padasiassa valitsemalla tyokalut kdyttéon asiayhteys-
valikon kautta. Yladvalikoista puolestaan 10ytyy seuraavia toimintoja:

File: Tyypillinen ”File”/’Tiedosto”-valikko, josta 16ytyy muun muassa tiedostojen
avaamiseen, tallentamiseen ja tulostamiseen liittyvid toimintoja.

Edit: Tyypillinen “Edit”/’Muokkaa”-valikko, josta 10ytyy muun muassa kopioi-,
leikkaa-, liitd-, etsi- ja korvaa-toimintoja.

View: View-valikossa voidaan mééritelld ndkyvissd olevat ikkunat ja tyokalurivit.

Tasks: Tasks-valikkoon on koottu kaikki aineistojen késittelyyn ja tarkasteluun liittyvét

SAS Enterprise Guide -tyokalut. Valikosta 10ytyvét aineistojen muokkaamiseen,
aineistojen kuvailevaan tarkasteluun, kuvien laatimiseen ja tilastollisiin analyysei-
hin liittyvit tyokalut.

Program: Program-valikko liittyy ldhinnd perinteisen SAS-koodin kdytt66n. Muun muassa
koodi-ikkunaan kirjoitettu SAS-koodi voidaan suorittaa tdmin valikon kautta.
Kuitenkin myds tavalliset tehtdvdsolmut voidaan suorittaa taalta.

Tools: Valikosta voidaan vaikuttaa moniin Enterprise Guiden yleisiin asetuksiin.
Help: Valikosta 16ytyy Enterprise Guiden Help eli ohje

Tulostusta tutkiessa saattaa tulostusikkuna tuntua turhan pienelti. Talloin voi kayttdd "Maximize
Workspace” -toimintoa, joka 16ytyy ”View”-valikosta. Sen avulla ty6tila suurentuu ldhes koko
ruudun kokoiseksi ja muut ikkunat menevét sivuun, pikalinkkien taakse. Muita ikkunoita saa
kétevasti ndkyviin viemélld hiiren kohdeikkunan pikalinkin péille.

Yksittdisen ikkunan voi myos siirtdd sivuun valitsemalla ”Auto Hide” valikosta, joka saadaan
nikyviin klikkaamalla x-symbolin vieressd olevaa alaspdin osoittavaa nuolta. Talloin ikkuna
menee samanlaisen pikalinkin taakse kuin "Maximize Workspace” -toiminnossa. Saman valikon
kautta voidaan tehdd my0s muuta kayttoympariston jarjestelyd, muun muassa siirtdd ikkunoiden
sijaintia ruudulla.

Ikkunoiden tai ikkunaryppéiden kokoa ja muotoa voi muokata tarttumalla niiden reunoista kiinni
ja venyttdmalla niitd. Ikkunoista voi siis muokata juuri itselleen sopivat. Ohjelma tallentaa ikku-
noiden jdrjestyksen automaattisesti EG:n lopetuksen yhteydessi, joten jérjestys palautuu saman-
laisena, kun EG kéynnistetdén seuraavan kerran. Ikkunat voi palauttaa alkuperéisille paikoilleen
valitsemalla ”Tools” -> ”Options” -> ”General”-vililehdeltd "Restore Window Layout”. Yksit-
tdisen suljetun ikkunan saa palautettua ”View”-valikosta.

Enterprise Guide tunnistaa automaattisesti erityyppisid tiedostoja. Enterprise Guideen voidaan
avata aiemmin luotuja Enterprise Guide -projektitiedostoja, joita ovat *.egp-tiedostot (EG versiot
3,4.1ja4.2)ja *.seg-tiedostot (EG versiot 1 ja 2). Avattaessa EG 4.2:een EG 3.0:ssa tai 4.1:ssd
tehty projektitiedosto, ohjelma kuitenkin huomauttaa, samasta tiedostotyypistd huolimatta, ettd
se on tehnyt projektitiedostoon tiettyjd muutoksia, jotka lopullisesti hyvéksytdén tallentamalla
projekti EG 4.2:ssd. Muutosten tallennuksen jédlkeen projektitiedostoa ei voi endd kdyttdd EG:n
vanhemmissa versioissa, joten tallennus kannattaa yleensd tehdd uudella nimell4, jolloin alkupe-
rdinen vanhemmassa EG:n versiossa luotu projektitiedosto sdilyy entiselldén.

Enterprise Guide tunnistaa monia erityyppisid datatiedostoja. EG:ssd voidaan ottaa kéyttoon
muun muassa SAS-datat (*.sas7bdat ja *.sd2), Excel-datat (* xls, * xIsx, *.xlsm ja *.xIsb) sekid
monen muun tyyppiset datatiedostot (*.dbf, *.db, *.txt, *.csv, *.asc, *.tab). Uutena ominaisuu-
tena Enterprise Guide 4.2:een voidaan lukea sisddn myos JMP (*.jmp), SPSS (*.sav) ja Stata
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(*.dta) -ohjelmien datatiedostoja omilla erillisilld tyokaluillaan. Erityyppisten data-tiedostojen
kayttoonotosta kerrotaan tarkemmin luvussa Aineiston kayttdonotto. Lisdksi Enterprise Gui-
deen voidaan avata muun muassa SAS-kooditiedostoja (*.sas), SAS-logitiedostoja (*.log) seka
SAS-raportti -tiedostoja (*.srx). Taydellisen listan Enterprise Guiden tunnistamista tiedostotyy-
peistd nikee esimerkiksi klikkaamalla: ”File” -> ”Open” -> ”Other” ja avaamalla tiedostotyyppi-
listan. Samasta “File” -> ”Open”-valikosta 10ytyy myds omat kohdat projektitiedostojen (”Pro-
ject”), datojen (’Data”) ja SAS-kooditiedostojen ("Code’) avaamiseen.

Tehtdva: Kaynnistd Enterprise Guide pikakuvakkeesta. Selaa valikoita, ikkunoita ja vélilehtid
saadaksesi alustavan kuvan Enterprise Guiden kéyttOympéristostd. Harjoittele myods ikkunoiden
muokkausta. Lisdksi voit harjoitella "Restore Window Layout” -toiminnon kayttdd, jos ikkunat
menevit epdjarjestykseen tai ovat edellisen kéyttdjan jéljiltd sekavassa jarjestyksessa.
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4 Enterprise Guiden ohje

Enterprise Guiden ohje 16ytyy klikkaamalla " Help” -> " SAS Enterprise Guide Help”. Samasta
valikosta 16ytyy myos " Getting Started Tutorial”, jossa kdyddan lapi EG:n perustoimintoja.
Siihen kannattaa tutustua itsendisesti. Varsinaisessa ohjeessa on eri kokonaisuuksia jérjestettynd
selkeiden otsikoiden alle, joten se on varsin kdyttokelpoinen ja toimiva. Esimerkiksi eri ana-
lyysityokaluihin 16ytyy apua klikkaamalla ohjeessa Siséllys-vélilehdeltd auki kansio Running
SAS Tasks”. Liséksi apua saa painamalla ndppdimiston F1-néppdintd Enterprise Guiden kéyton
lomassa, jolloin EG avaa automaattisesti ohjeesta sellaisen sivun, joka liittyy silld hetkelld kay-
tossd olevaan osaan EG:td. Enterprise Guiden ohjeen lisdksi on usein tarpeen kiyttdd myds
tavallisen SASin ohjetta. Sen 10ytdad kitevasti EG:n “Help”-valikosta valitsemalla ” SAS Syntax
Help”. Tama ohje on paljon tdsmillisempi ja laajempi yksityiskohtien suhteen kuin Enterprise
Guiden ohje.

Myo6s muokattaessa tehtdvisolmua (tehtdvdsolmujen muokkausta kisitelldin oppaassa myo-
hemmin) ohjeita on runsaasti tarjolla:

Il Bar Chart4 for Local:SASUSER.VILJELIJAZ006

Bar Chart Data
Data
Appearance
Bars Data zource:  Local:SASUSER VILIELIAZDOE "
. . . Edit..
Layout Task filter: Mone 2) Apuanlmaatlo
Axes
General
Horizontal Avis Coluring to assign: Task rales:
Az -
erting] du MName M Column b chart [Limit: 1]

1) Klikattaessa hiirelld
jotakin kohdetta alareu-

4 Group charts by :

nan ohjelaatikkoon il- ® 3) Téstd painamalla PT—
1 mestyy sithen liittyva saadaan auki varsi-
1 selitys. nainen ohje oikeasta

T kohdasta (vastaa F1-

S nédppdimen painamis-

@ tulevais ta).

The column that you assign to this role determines the lengths of the bars. You choose the particular statistic that is c3kulated to determing
bar length in the Advanced area. If you do not assign a column ko this rale, then the frequency of each value of the Columkta chart calurn
determines the lengths of the bars or the sizes of the sections.

(o )=

The "Calumn ko chart” rale must have a variable assigned ko it.

Aiemmin tavallista SASia kayttineille EG:n hahmottamista saattaa helpottaa tieto Enterprise
Guiden tydkalujen taustalla kayttdmista SAS-proseduureista. Valitsemalla ”Task list” -ikkunassa
”Tasks by Name”, saadaan kunkin tydkalun viereen nikyviin maininta sen kdyttdmistd SAS-pro-
seduureista.

Liséksi “Help”-valikon kohdasta " SAS on the Web” 16ytyy monta hyodyllistd linkkid internet-
sivustoille. Sielld on muun muassa linkkejd, joiden takaa 16ytyy lisdmateriaalia EG:n kdyton hel-
pottamiseksi ja harjoittelemiseksi sekd erilaista teknistd tietoa (muun muassa linkki EG:n hotfix-
korjaustiedostoihin).
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5 Aineiston kayttoonotto

5.1 Kirjastoviite

Kirjastoviite on SAS-ohjelmiston kadyttimi menettelytapa, jossa avainsanalla viitataan tiettyyn
hakemistoon tai kansioon tietokoneella. Sitd tarvitaan esimerkiksi, kun halutaan maéritelld mihin
tictokoneen kansioon istunnon aikana luodut SAS-datat tallennetaan tai mistd kansioista aiem-
min luodut SAS-datat otetaan kayttoon.

Kirjastoviitteen luominen

Tassé esitettdva tyokalu tuottaa kirjastoviitteen, joka on voimassa EG-istunnon ajan. Kun Enter-
prise Guide tai projekti kdynnistetddn uudelleen, pitdd kirjastoviite muistaa istunnon aluksi yh-
distdd uudelleen haluttuun kansioon suorittamalla kirjastoviitteen mééritteleva tehtavisolmu uu-
delleen.

Kirjastoviite luodaan kiyttden siihen tarkoitettua Enterprise Guiden tydkalua klikkaamalla
"Tools’ -> "Assign Project Library...”. Aukeavassa ikkunassa médritelladn vaihe kerrallaan
kirjastoviite.

Ensimmadiselld sivulla annetaan kirjastoviitteelle nimi (esimerkiksi kir):

= Assign Project Library

1 of4 Specify a name and server for the library. gsas

Thiz wizard azzignz a library for the current project and the current user. This library will be un-aszigned when vou exit the
application. [ you want to create a permanent libram on a server, create a server library definition by going ta menu Tools-»
Enterprize Guide Explorer.

Mame [enter 8 or fewer characters):

KIR < Kirjastoviitteelle annetaan nimi
Server: kohdassa ”Name”.
Local - The 545 server on your machine w

T~

Kohdassa Server” wvalitaan SAS-palvelin, jossa kirjastoviite
luodaan. Téssd oppaassa kéytetddn omalla tietokoneella olevaa
SASia ("Local”).

Mexts Cancel Help
J
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Toisella sivulla valitaan kansio, johon kirjastoviite viittaa, allaolevassa kuvassa esimerkki viit-
taamisesta “Omien tiedostojen” alla olevaan \SAS\EGKURS -kansioon. (”Engine” puolestaan
saa olla oletuksena oleva "BASE”, kun kirjastoviitettd kdytetddn SAS-datojen késittelyyn):

&' Assign Project Library

2 of4 Specify the engine for the librany. S.Sas

Engine twpe:

File System “

Additional information needed for File Syzten'

[] Let 545 chaose the engine based on the contents of the specified path.

Enaine:

B&SE - Latest version of Bage 545 w
Path:

C:ADocuments and SettingshkayttajatunnushOmat tiedostothsashegkurs

\ el

Tietokoneen kansio, johon kirjastoviitteen halutaan viittaavan,
voidaan madrittdd kirjoittamalla kyseinen hakemistopolku
kohtaan ”Path” tai "Browse”-painikkeen kautta.

I <Back 'H Mexb: J I Cancel H Helpj

Loput sivut voi yleensé klikata ohi painamalla ”Next” ja viimeiselld sivulla valitaan Finish”.

Vaihtoehtoinen ratkaisu SAS-koodilla;

Istunnon ajan voimassa oleva kirjastoviite voidaan toteuttaa myds SAS-koodin avulla.
Koodieditorin saa avattua klikkaamalla “File” -> "New” -> “Program”. Téssa koodi-
ikkunassa voi madrittda kirjastoviitteen samoin kuin perus-SASissa, esimerkiksi:

LIBNAME kir 'C:\tahanpolkua\sas\egkurs';

Siind kir on kirjastoviitteen nimi ja yksinkertaisten lainausmerkkien sisdlld on
hakemistopolku, jonka osoittamaan kansioon kirjastoviite viittaa. Koodin voi suorittaa
muun muassa valitsemalla ”Run” asiayhteysvalikosta tai klikkaamalla koodisolmua
prosessidiagrammissa hiiren oikealla painikkeella ja valitsemalla ”Run Program on
Local”. Huomaa, ettd suoritettacssa sama tehtdvd sekd valikkotyokalulla ettd koodin
avulla, aiemmin luodun tehtdvin tulokset saattavat korvaantua jalkimmaisen tuloksilla!

SAS-koodia hyoddyntden voidaan luoda myds kirjastoviite, joka yhdistetddn
automaattisesti aina EG:n kdynnistyksen yhteydessd. Se onnistuu kohdassa ”Tools” ->
”Options” -> ”SAS Programs” ruksaamalla vaihtoehto ”Submit SAS code when server
is connected” ja lisddamailld kohdan perdssd olevan “Edit”-painikkeen kautta aukeavaan
koodi-ikkunaan kirjastoviitteen luova SAS-koodi.

Tehtava: Tee tictokoneelle “Omien tiedostojen” alle kansio \SAS\EGKURS ja kopioi sinne ta-
hin oppaaseen liittyvdt datatiedostot, jotka l0ytyvit zip-pakattuina internetisti osoitteesta:
http://www.mtt.fi/mttraportti/pdf/egdata/EG42datat.zip. Luo istunnon ajan voimassa oleva Kkir-
jastoviite nimelta kir, joka viittaa kyseiseen kansioon.
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Kirjastoviitteen asettaminen oletukseksi

Oletuskansio, johon eri tehtdvdsolmut ehdottavat datoja ja tulosteita tallennettavaksi, on mah-
dollista vaihtaa. Se onnistuu klikkaamalla “ Tools” -> “Options’ -> “Tasks” -> “Output Lib-
rary” ja vaihtamalla sielld ndkyvien kirjastoviitteiden jérjestystd. Jarjestystd voi vaihtaa valitse-
malla jonkin kirjastoviitteen aktiiviseksi ja siirtdmalla sitd ”Up”- tai "Down’’-painikkeilla. Uuden
kirjastoviitteen saa lisdttyd lista